# Table of Contents

- Objectives.................................................................................................................. 3
- Introduction to the Sabre System.................................................................................. 4
- Equipment and Keyboard ............................................................................................. 5-9
- Signing System Keyboard ............................................................................................ 10-13
- Using the Memo Area.................................................................................................... 14-15
OBJECTIVES

Upon completion of this class, you will be able to:

- Describe the Sabre global distribution system equipment and keyboard
- Sign in and out of the Sabre system
- Change to a different work area
- Place text in the Memo Area
Welcome to the Sabre® system!

The Sabre® system has consistently been rated the number one Global Distribution System (GDS) in the world and continues to maintain a leadership position in bookings share. You now have at your fingertips a host of technology solutions that will serve as your gateway to a wide variety of travel and travel-related services.

Sabre Travel Network® connects travel buyers and sellers through the world’s largest global distribution system, providing over 50,000 travel agency locations with instant access to content from airlines, hotels, car rental companies, cruise lines and more.

Our end-to-end corporate and leisure solutions help you work smarter, reduce costs, generate more revenue and build stronger customer relationships.

Whether you’re in transition from proficiency with another Global Distribution System to the Sabre® system or are new to the travel industry, we want to help you gain a working knowledge and understanding of the Sabre system as quickly as possible. It is not important to remember all the formats. Memorization of formats will come with time. However, it is important for you to know where to locate the answers to your questions and to feel confident in planning your continued training.

If known, record your agent ID, agent sign, and agency pseudo city code below for reference.

Agent ID: _____________
Agent sign:  _________
Agency Pseudo City Code (PCC):  _____________
## Component Function

1. **PF keys**
   - Also called function keys. Used to store formats that are used repeatedly.

2. **Main keyboard**
   - Number and letter keys used for most typing and entry functions.

3. **Miscellaneous keys**
   - Used to insert and delete information, reenter, reset cursor to top left margin of screen, and place text in the upper portion of the screen.

4. **Arrow keys**
   - Used to move the cursor up, down, left, and right on the screen.

5. **Numeric key pad**
   - Functions as a calculator.

6. **Alt key**
   - Performs a function if depressed in conjunction with another key.

7. **Ctrl key**
   - Performs a function if depressed in conjunction with another key or keys.

8. **Identification Code Keys (ICK)**
   - Agents use these keys, combined with letters and numbers, to perform specific functions in the Sabre system.
## IDENTIFICATION CODE KEYS (ICK)

Use the keys below for particular functions, such as create or display a Passenger Name Record (PNR).

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Description and Sample Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Availability</td>
<td>Displays city pair availability. 122JANFRAMAD</td>
</tr>
<tr>
<td>2</td>
<td>Flight Information (FLIFO)</td>
<td>Request flight Information. 2UA2550/17OCT</td>
</tr>
<tr>
<td>3</td>
<td>General Passenger Information (GFAX)</td>
<td>Send general passenger information to all airlines except American Airlines. 3OSI DL HAS BROKEN LEG</td>
</tr>
<tr>
<td>4</td>
<td>General Passenger Information for AA (AFAAX)</td>
<td>Send general passenger information to American Airlines. 4OSI HAS BROKEN LEG</td>
</tr>
<tr>
<td>5</td>
<td>Remarks</td>
<td>Add remarks about the passenger or the reservation. 5NEEDS HYATT HOTEL IN SYDNEY</td>
</tr>
<tr>
<td>6</td>
<td>Received From</td>
<td>Add “received from” (the person from whom the reservation request was received). 6NIGEL</td>
</tr>
<tr>
<td>7</td>
<td>Ticketing</td>
<td>Add ticketing deadline. 7TAW22JAN/</td>
</tr>
<tr>
<td>8</td>
<td>Time Limit</td>
<td>Add time limit – automatically cancels the reservation if no ticket is issued. 86P/17JUN</td>
</tr>
<tr>
<td>9</td>
<td>Phone Number</td>
<td>Add phone number. 9415-555-2121-H</td>
</tr>
<tr>
<td>0</td>
<td>Sell Segment</td>
<td>Sell segment (air, car, hotel, etc). 01Y1</td>
</tr>
<tr>
<td>-</td>
<td>Name</td>
<td>Add passenger name. -ALONSO/EDITH</td>
</tr>
<tr>
<td>* (=)</td>
<td>Display</td>
<td>Displays information when used in combination with other characters. *-SANCHEZ</td>
</tr>
</tbody>
</table>
## Other Identification Code Keys

<table>
<thead>
<tr>
<th>Key</th>
<th>Name</th>
<th>Description and Sample Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>/</td>
<td>Insert After Segment</td>
<td>Used to rearrange segments (Example: insert after segment 0 insert segment 2). /0/2</td>
</tr>
<tr>
<td>.</td>
<td>Change Segment Status</td>
<td>Used to change the action/status code of a segment. .2HK</td>
</tr>
<tr>
<td>,</td>
<td>New Number in Party</td>
<td>Used to change the number in party. ,2</td>
</tr>
<tr>
<td>{</td>
<td>Change</td>
<td>Used to change, delete or calculate information. 91=214-555-2121-H</td>
</tr>
<tr>
<td>$</td>
<td>End-Item</td>
<td>Used to string several Sabre system entries together. -PARK/JOHN MR§9305-555-3442-B§6JOHN§7TAWW22JAN/$</td>
</tr>
<tr>
<td>¥</td>
<td>Cross of Lorraine</td>
<td>Used as a separator. W¥PG1¥KP0¥ALH</td>
</tr>
</tbody>
</table>

## Editing Keys

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
</table>
| Left and Right arrow keys | May be used to move forward and backward through a format to position the cursor and type over mistakes.  
**Note:** Though the Up and Down arrow keys can be used to move the cursor, the system cannot read the starting point if these keys are used. Use the Reset key to make sure the system knows where the entry begins. |
| Insert and Delete keys   | May be used to insert and delete characters in a format. Often used in conjunction with the Left and Right arrow keys to insert or delete characters after moving forward or backward through a format. |
**SPECIFIC FUNCTION KEYS**

Specific keys allow you to transmit information to the system, reposition your cursor, and even clear your screen. The location of these keys may be different on the keyboards in your office, but the functions of the keys are the same.

**Note:** The cursor is a blinking character on the Sabre system screen that indicates placement of the next character to be typed. The cursor automatically returns to the left margin after every entry.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT + Backspace</td>
<td><strong>Clear</strong> Used to clear the screen without canceling or changing any of the data previously entered. The cursor is returned to the upper left corner of the screen.</td>
</tr>
<tr>
<td><strong>Home</strong></td>
<td><strong>Clear</strong> Moves the cursor from the current position to the upper left corner of the screen. Data on the screen is not erased. This key will reset your SOM (Start of Message). You may use it to return the cursor to the top of the screen after entering data or requesting information from the system.</td>
</tr>
<tr>
<td><strong>Escape</strong></td>
<td><strong>Clear</strong> Returns the cursor to the left margin of the screen, one line at a time, without erasing the previous line. This key will reset your SOM to the beginning of the next line on your screen. If you have begun an entry that you do not want to complete, you may use this key to disregard the current entry and begin a new one.</td>
</tr>
<tr>
<td><strong>Reset</strong></td>
<td>If the “Sabre Keyboard” mode (under the Options menu) is active, this key may also be used as a Reset key.</td>
</tr>
<tr>
<td><strong>ReEnter</strong></td>
<td><strong>Clear</strong> Allows you to input a previously entered format without retyping all of the data. After making a correction to a format, moving the cursor to the end of a long entry before pressing Enter can be tiresome. The ReEnter key moves the cursor quickly to the end of the entry and resends it to the system.</td>
</tr>
<tr>
<td>ALT + Up</td>
<td><strong>Replay</strong> Redisplay the last format entered. You can replay approximately 350 of your most recent Sabre system entries.</td>
</tr>
</tbody>
</table>
OVERVIEW

Employee Profile Records (EPRs) are an element of the Sabre® global distribution system’s security that governs the capabilities of agents using the Sabre system. Your EPR enables you to sign into the Sabre system and controls which functions you can or cannot perform in the system.

EPRs contain many different components including:

- agent id – use this to sign-in
- agent sign - identifies each specific agent
- office code – allows you to group agents by job function
- duty codes – allow specific functionality
- keywords – allow specific functionality
- passcode (password) – secures your sign-in and allows access to the system

EPR example. See the Format FinderSM help system for a detailed explanation of each EPR field.

Note: Find more information about EPRs in the Format Finder help system.

NEW AGENCY - INITIAL EPR AND PASSCODE

Every new Sabre ConnectedSM agency is issued one initial EPR and a temporary (default) passcode. You will use this EPR and passcode the first time you sign-in to the Sabre system.

- You must change your initial EPR passcode, your new passcode must consist of 7 or 8 alphanumeric characters and it may NOT include Q or Z.
- You must then use this initial EPR to create an EPR for yourself and for each agent.

Important Note: To ensure agency security, it is important to DELETE the initial EPR.

PASSCODE REQUIREMENTS

Follow these requirements when creating or changing your Sabre system passcode. All new EPRs you create must have a passcode before you can end transaction and activate the EPR.

- Must be 7 or 8 alphanumeric characters
- Must contain at least 1 alphabetic and 1 numeric character
- Cannot contain a Q or Z
- You cannot reuse your last four passcodes
- No 3 character months JAN, FEB are restricted
- No sequence of numbers or characters 1234 4321 ABCD
- Cannot repeat one character more than two times (for example. AA is allowed, AAA is not allowed)
- Cannot use standard words or proper names (for example. DALLAS or FROG are not acceptable)
  - You receive this error response CONTAINS RESTRICTED WORD - NEW PASSCODE UNACCEPTABLE

Note: Find more information about EPRs in the Format Finder help system.
**Duty Codes**

*Note:* Duty codes are system access rights that determine the range of functions that an agent can perform in the Sabre system. These are stored in your EPR and vary according to an agent’s duties.

If your EPR allows it, you can also switch duty codes, when necessary, in order to perform different functions.

The three duty codes, along with the access rights provided by each, are:

- * - Allows agent full reservations access for normal Sabre system activity
- 9 – Allows agent supervisory and managerial access for those responsible for management functions
- 6 – Allows agent to access the training mode, providing the ability to practice without impacting actual customer records

**Work Areas**

The Sabre system has six work areas, identified as A, B, C, D, E, and F. You sign in to all six of these system work areas by entering an asterisk (*) prior to your identification number as follows.

**Sign In**

**Format**

**Step 1:** Type Si* followed by your agent identification number

Si*(identification number)

System Response:

AGENT SIGN IN

    CURRENT PASSCODE   ID  <000000>  SUF  <PCC0 >
    DUTY CODE   <*>   AREA   <*>   NEW PASSCODE

**Component**

**Description**

CURRENT PASSCODE
Type your current passcode (it will not appear when typed)

ID
Reflects agent identification number

SUF
Reflects agency pseudo city code (PCC)

DUTY CODE
Reflects duty code or level of access

AREA
Reflects the area to be signed in

NEW PASSCODE
Area where you can change your passcode

**Step 2:** Type your passcode in the sign-in mask

(Passcode) PASSWRD1
### SIGN IN SYSTEM RESPONSE

<table>
<thead>
<tr>
<th>Your Active pseudo city code (dot) your Agency home pseudo city code</th>
<th>Current date</th>
<th>Your duty code</th>
<th>Your individual agent sign</th>
<th>The work areas signed in</th>
<th>Sign in message</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCC0.PCC0</td>
<td>ALJ..A.B.C.D.E.F.</td>
<td>19JUN</td>
<td></td>
<td></td>
<td><strong>SABRE EXCLUSIVES <em>SA</em> LOWEST AVAILABLE HOTEL RATES</strong>&lt;br&gt;2-5 STAR HOTELS 10PCT COMP GUARANTEED WITHIN 2 WEEKS&lt;br&gt;<strong>INTER-CONTINENTAL <em>THE WHOLE WORLD-HALF OFF</em> SUMMER</strong>&lt;br&gt;SPECIAL BKFAST AT PARTICIPATING HOTELS - HODIC/HOT</td>
</tr>
</tbody>
</table>

### SIGN OUT FORMAT

The *Sabre* system tracks all entries by agent sign. When you are through working in the system, you should sign out to prevent other individuals from making entries using your passcode.

- **Sign out of the current work area**
  - Command: `SO`
  - System Response: `B SIGNED OUT`

- **Sign out of all work areas**
  - Command: `SO*`
  - System Response: `A.B.C.D.E.F..SIGNED OUT`

### WORKING WITH WORK AREAS FORMAT

When you leave a work area, it becomes inactive until you return to it. Entries made in the active area do not affect the work you do in another area. When you return to an area you previously left, that area becomes active again.

**Note:** All items to be recorded in a single Passenger Name Record (PNR) should be completed in the same work area.

- **Change to a different work area:** A, B, C, D, E, or F
  - Command: `p(work area letter)`
  - Command: `=D`
  - System Response: `PCC0.PCC0*ALJ..D`

- **Display current work area**
  - Command: `*S`
  - System Response: `PCC0.PCC0*ALJ..D`

- **Display the status of all work areas**
  - Command: `*S*`
  - System Response: `PCC0.PCC0*ALJ.A..PNR PRESENT<br>ACTIVE AGENT – L. JONES – 000000-PCC0<br>PCC0.PCC0*ALJ.B..PNR PRESENT<br>PCC0.PCC0*ALJ.C..PNR PRESENT<br>PCC0.PCC0*ALJ.D..<br>PCC0.PCC0*ALJ.E..<br>PCC0.PCC0*ALJ.F..<br>`
Display the status of all work areas, along with assigned printers

*S*P

System Response:

PCC0.PCC0*ALJ.A..PNR PRESENT
ACTIVE AGENT - L JONES - 000000-PCC0
H1-AB123C AT T-AB123D I-AB123E
PCC0.PCC0*ALJ.B
H1-AB123C AT T-AB123D I-AB123E
PCC0.PCC0*ALJ.C
NO PRINTERS
PCC0.PCC0*ALJ.D
NO PRINTERS
PCC0.PCC0*ALJ.E
NO PRINTERS
PCC0.PCC0*ALJ.F
NO PRINTERS

Redisplay the sign in message

S/*

System Response

PCC0.PCC0*ALJ.B..PNR PRESENT
15JUN
*SABRE EXCLUSIVES *SA*.LOWEST AVAILABLE HOTEL RATES*
2-5 STAR HOTELS 10PCT COMM GUARANTEED WITHIN 2 WEEKS
**INTER-CONTINENTAL- *THE WHOLE WORLD-HALF OFF* SUMMER*
SALE INCL BFAST AT PARTICIPATING HOTELS -HODIC/HOT

SWITCH DUTY CODES

When you sign in to the Sabre system, the duty code defaults to *. However, some entries require that you sign into the Sabre system using a special duty code. You can activate an assigned duty code without signing out and signing back in.

<table>
<thead>
<tr>
<th>Change duty code</th>
<th>SI(duty code)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: This format activates duty codes that already exist in your Employee Profile Record (EPR); it does not update or change your EPR.</td>
<td>System Response</td>
</tr>
<tr>
<td>F O R M A T</td>
<td>SI9</td>
</tr>
<tr>
<td>PCC0.PCC09ALJ..A..*ALJ.NOT SIGNED OUT</td>
<td></td>
</tr>
</tbody>
</table>

ADDITIONAL REFERENCES

Additional quick references and interactive tutorials are available on the Web at http://agencyeservices.sabre.com/ under the Training menu. You may also find additional information in the Format FinderSM help system. Use these keyword combinations or formats in your Search request:

- **EPR**
- **Passcodes**
- **Duty Codes**
- **Work Areas**
OVERVIEW

The Memo Area provides a section of the Sabre Work Area where you can temporarily place information for viewing. You can use the Memo Area as a notepad to record pieces of information that may be needed later in making a reservation. It may be especially helpful when you have information that is needed in multiple reservations. The Memo Area is not an active work area in the system and is used only to store information. Text in the Memo Area of the screen will not inhibit any functionality.

DISPLAY THE MEMO AREA

The Memo Area option on the “View” menu toggles the Memo Area between being visible and not visible. When “Memo Area” is preceded by a checkmark, it is active and will be visible.

- Click View to display the “View” menu (Alt-V)
- Click Memo Area to activate or deactivate the Memo Area option (M)

Note: You can still send information to the Memo Area even when it is not visible. Then when the Memo Area is active, you will see the information you stored there earlier.

PLACING TEXT IN THE MEMO AREA

The Memo Area appears close to the top of the Sabre Work Area below the menu bar. You can type on the Memo Area or:

- Type the text in the Sabre Work Area
- Press the Memo (End) key to place text in the Work Area.

A scroll bar at the right of the Memo Area, allows you to scroll through the information you have placed in this area.

Information will remain in the Sabre Work Area until it is removed. Clearing the Work Area does not erase text from the Memo Area.
**ERASE THE MEMO AREA**

To erase the text from the Memo Area only  
press **Alt+Memo (Alt+End)**

To clear the text from the Sabre Work Area only  
press **Alt+Backspace**

To clear both the text from the Memo Area and the Sabre Work Area  
press **Ctrl+Backspace**